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From The Editor’s Desk

PhotographyBB Online Magazine Fourth Edition - Late but GREAT!

Welcome to our fourth issue of the PhotographyBB Online Magazine. I’d like to start 
by addressing the fact that this issue’s release was one week later than originally 
planned. This month, we had several members out of town enjoying much deserved 

vacation time, and as a result we needed one extra week to make the magazine as perfect as 
can be.  As for future issues, we’ll have them out on time as scheduled for release on the second 
Tuesday of every month, so that will make the Issue 5 release date to be June 10th, 2008.

This month we’re in for a special treat, as my father (a published and distinguished author) 
is joining us in the Photography Around the World section. In collaboration with Tourism 
Vancouver, Euclid Seeram gives us a fascinating look at the city of Vancouver, home of the 
2010 Winter Olympic Games. It was a pleasure to have my Dad writing for the magazine, and 
finally gave me an opportunity to tell him what to do for a change!

I’d like to welcome back Fred McWilson as a regular contributor to the magazine. Fred will 
be brining his experience in the areas of Photoshop and HDR techniques. This month, Fred is 
going to expand on his previous OOB (Out-Of-Bounds) tutorial, with some advanced frame 
warping techniques. Fred also hangs out on the PhotographyBB Forums, where you can chat 
with him, any of the other contributing authors, or myself for that matter.

Jon Ayres gives us some great tips and techniques for shooting street photography. 
Jon also dives into some ethical issues surrounding street photography, which are thought-
provoking and provide some insight into what it takes to bring your street photography to the 
next level.

Ken Fagan put countless hours into this issue for us. This month, he take’s a break from 
camera functions (in the Photography 101), and gives us a look at shooting techniques for 
everyone’s favourite summer outing - a day at the zoo. Ken also gives us a great look at the 
history of 35mm cameras, providing a glimpse into where our fancy new digitals came from. 
Ken also made a trip out to Vancouver this month (where he graduated with a Diploma in 
Photography), so we had a chance to go on some fun photo-shoots, which are sure to form 
some great topics for Issue 5.

Victoria Sargsyan also helped out a lot this issue, continuing in her tutorial tradition. This 
month, she provides the Elements users with some quick and easy tips for enhancing and 
fixing photos, as well as a brief primer on setting up Dreamweaver, in a series which will walk 
the photographer through building their own online gallery website.

As a final word, I’d like to welcome all of the new forum members this month. It’s been great 
getting to know you all, and I’ve been enjoying your photos and techniques. I look forward to 
meeting any new members who join us along the way. Please stop in, register, and say hi!

Dave Seeram
Editor and Publisher

Dave Seeram is the Editor in Chief for PhotographyBB Online Magazine. As 
the administrator of the PhotographyBB Website and Forums, Dave is also 
an experienced author of several Photoshop® Actions and Tutorials which 
can be found on http://www.PhotographyBB.com
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DAVE SEERAM is the creator of the PhotographyBB 
Online Website, and the Administrator of the 
PhotographyBB Forums. Dave is a digital photography 
enthusiast, and loves shooting landscapes and architec-
ture in his spare time. Additionally, he has several years 
of formal training in both Adobe Photoshop® and Quark 
Xpress®. 

KENNETH FAGAN is a photographer extraordinaire 
based in Meath, in the Republic of Ireland.  Ken gradu-
ated with a professional Diploma in Photography from 
the Focal Point School for Visual Arts in Vancouver. His 
specialities are product and food photography, but he is 
also skilled in fashion, sports and landscapes. Ken works 
with many camera formats including, 35mm pro digital 
and film SLRS, medium format, and 4x5 large format. 

JON AYRES is a digital photographer from the United 
States, now living in Moscow since August 2003. He 
enjoys photography, writing, history, and taking beautiful 
scenes of Moscow on his walking photo-tours. Jon has 
been involved in writing, digital art and photography for 
over thirty years and is a published author having several 
articles and photos published. 

VICTORIA SARGSYAN is a professional graphic de-
signer from Armenia, now living in the United States. 
She brings over 15 years of professional experience in 
graphic design, and her favorite software tool is Adobe 
Photoshop. Additionally, she is experienced in Illustrator, 
CorelDraw, Freehand, Lightroom, Adobe ImageReady, 
Flash,HTML, Dreamweaver, Motion Artist, Anime Studio, 
Poser.

FRED MCWILSON is a photographer and Photoshop-
wizard from southeast Missouri. We’re pleased to have 
Fred with us as a Photoshop tutorial and HDR column 
author. Some of his hobbies other than Photoshop and 
photography are caving and paintball. 
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The versatility of the 35mm camera could not be 
matched by the bulky 4x5 camera or the medium 
format’s low images per roll output. It dawned 

a new era in photography and brought its popularity 
to a whole new level. The first 35mm film was created 
in the early 1890s by Thomas Edison when he cut 
a standard medium format roll of film in two strips 
that both measured approximately 35mm in width, 
and each strip had a row of guide holes along each 
side to aid the films advance. Since then, the 35mm 
format has become one of the most popular and most 
recognized of all the formats. The first 35mm camera 
to become popular was the American Tourist Multiple 
from 1913. From that, the camera developed and in 
the 1920s Leica began to produce their own line of 
35mm cameras, where they developed a reputation 
for outstanding build quality and an excellence in lens 
precision. The Leica cameras also accepted the 35mm 
film in a specially designed cartridge. Each frame on a 
35mm camera measures 24mm x 36mm.

The 35mm film cartridges were designed to be 
reused by loading a new spool of film into the cartridge 
before loading it into the camera system. In 1934 the 
Kodak company released a film cartridge which could 
be used in Kodak’s own range as well as Leica and in 
another camera manufactured by Contax. The re-usable 
film cartridges developed into the single use cartridge 
of today, although it is still possible to purchase bulk 
rolls of film and load it into re-usable cartridges. By 
1935 a range of colour 35mm film was available from 
Agfa with the Agfacolor and Kodak’s Kodachrome.  

The original 35mm cameras were built using 
a rangefinder system for focus and framing. The 
rangefinder is a system where through the focusing 
screen you see two images. Focus is then achieved 
when the two images blend into one image, this is 
where the rangefinder has calculated the distance of 
the subject from the focal plane. If a photograph is 
taken where the two images have not met, the result 
will be out of focus. See the image (on the following 
page) of an Agfa Ambi-Silette, also known as the poor 
man’s Leica. This was a camera which was part of a 
popular Agfa range of the 1950’s to the late 1960s. They 
were one of the top-of-the-range cameras of their time 
and the model shown here is of the 1959 edition. After 
the rangefinder revolution, a new camera system was 

Before There Was Digital...
Have you ever stopped to think about the other camera formats out there?  
In our last month’s issue, I introduced you to the world of large format 
photography. This month I’ll be writing about how the 35mm camera 
took the photography world by storm and became thee choice for many 
photographers for decades.

FILM: THE 35MM MIRACLE - By Kenneth Fagan

Since the dawn of film, the camera has often been just the luxury of the journalists and the wealthy aristocrats. 
With equipment often costing a small fortune, the camera was out of reach for most. By the middle of the 1900’s 
photography became more popular with the consumer and so the need for a more convenient user-friendly 
system was greater than ever. And so came about the birth of miniature photography. 

Closeup view of a rangefinder system.
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introduced into the market. A single lens reflex 35mm 
camera was first built by a German camera company 
called Ihagee in 1936. 

The original versions of the SLR had a pentaprism 
viewing system, which is a five sided prism where 
an image is reflected to allow for eyelevel viewing. 
Whatever you seen in the view finder is what is actually 
in the frame of the image, unlike the twin lens reflex 
of the medium format or the 35mm rangefinders. The 
Pentaprism system was developed by a company called 
Zeiss in the late 1930’s after Ihagee released their Kine-
Exacta. The pentaprism allowed the image to be viewed 
in the correct orientation. The next new addition to 
the SLR was the Fresnel lens: A Fresnel lens is a flat 
piece of glass with concentric prismatic grooves which 
distributed the light hitting the image in almost parallel 
lines. The Fresnel lens was used with the addition of a 
piece of ground glass. The combination of the Fresnel 
lens and the ground glass allowed the photographer 
to view the image in the view finder with an amount of 
light the same or similar to that entering the lens. 

With ever improving SLR designs, the pentaprism 
system was eventually replaced with a mirror, which 
is what we find in all SLR’s today. Originally the mirror 
was manually reset after each exposure, and it wasn’t 
until the late 40’s and early 50’s that an automatic 
mirror system was built, by which once an exposure 

was complete the mirror would return to its original 
position. This was a turning point in how the SLR’s 
viewing system was created and the general design 
still holds today. 

The 35mm system became the preferred choice 
for Journalists and Lifestyle photographers, gaining 
its popularity from the fact that you could shoot up 
to 36 frames per roll without the hassle of re-loading 
(although there are 35mm rolls with 24 or 45 frames). 
The 35mm format turned out to be one of the great 
photographic successes of the 20th century. Although 
the medium format film has a much greater exposure 
area hence a considerably higher resolution, the 35mm 
frame scaled down the size of the camera considerably 
and could develop images that were of a high standard 
of quality with results that were quite acceptable for 
most photographic disciplines. Today the 35mm SLR 
range is huge with manufacturers such as Canon, 
Nikon, Pentax, Sony, Olympus, and Leica all striving to 
have the best on the market. 

It should be noted since many people don’t realize 
it, but just because you scrapped your old film SLR 
for a digital does not mean you have a better camera. 
For example, a 35mm exposure on film is actually 
the equivalent to a 12 or 15 mega pixel SLR. Over the 
past five or six years, the 35mm SLR has been slowly 
replaced by the digital camera. People purchase 
small compact digital cameras to replace their 35mm 
compact. I have seen where people have shown me 
the images off their digital compacts and the results 
are so poor that they would have been better off 
to spend $10 on a disposable which can yield more 
than acceptable photographs. I still use my 35mm 
SLR as well as my digital, as some things I just prefer 
to use film with, such as long exposures or nighttime 
photography. To be honest, the results of both can 
often be indistinguishable. 

 
If you are the type of person that loves film 

photography and hates the thoughts of it disappearing, 
keep it alive by using film where you can. Don’t be put 
off by the whippersnappers who reckon film is old 
school and for people who don’t have a digi-tech savvy 
head. Give the guys with the smug grin and a flashy 
digital camera a roll of film and an SLR and they will 
more than likely run a mile.

 
Photography is a fantastic thing for everyone to 

enjoy. Whether you use film or digital the important 
thing is that you enjoy it. If you want to go digital but 
don’t want to change your film camera, perhaps a 
good investment would be a film scanner. You are not 
limited in what you do when you shoot with film, the 
amenities are out there so if you feel strongly about 
your film don’t be discouraged by the increasing swing 
for digital photography. A look inside today’s modern SLR camera.

This article and photographs contained are Copyright © and courtesy of Kenneth Fagan. Please contact the author directly with any questions.
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Street Photography
The Photographer’s Ultimate Studio - By Jon D. Ayres

Of all the types of photography I do, I 
think street photography is one of my 
favorite types of photography.  To me, 

the street is my studio and I can photograph 
just about anything, especially real life scenes 
if you go about it right.  When I’m on the street 
photographing, I’m always looking for real 
slices of life, expressive moments, funny scenes, 
interesting people, a fleeing expression, or 
photos which tells a tale. Sometimes I like to 
find a spot to stay and watch the world passing 
by where I’m totally focused on the scene and 
sometimes I become part of the scene I am 
constantly watching, listening, looking and 
seeing.  Street photography can be one of the 
hardest types of photography to do; you have 

so many different variables and varieties of 
both subjects and problems to deal with.  

Of course in today’s world with privacy and 
security a major concern you sometimes have 
a overzealous officer, guard or neighborhood 
busybody over-react, and it’s a fact that not 
everybody likes to be photographed or have 
their property photographed. Those don’t 
have to become issues at all considering that 
there is so much to photograph on streets, 
just like one huge studio where you can 
photograph portraits reflecting the beauty, 
the good, the bad and the ugly in life.  Old and 
new architecture, everything which composes 
this drama and comedy in the play called life.  
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Day to day life, solitude and the maddening crowds, a 
city’s streets is its lifeblood.  Everything from bees flying 
from flower to flower, old and new architecture, river 
walks, ponds, lovers strolling along the embankment 
at sundown, everything can be photographed on a city 
street which can be seen from public view.  It makes 
no difference if it’s a small village street or a city as 
large as Moscow, city streets are the photographer’s 
ultimate studio.  Often street photography is referred 
to as ‘No Rules Photography.’  Forget all about those 
silly rules of thirds, f stops, shutter speeds and all those 
other distractions, street photography is real no rules 
photography.  I like to refer to street photography 
as real photography; very few posed shots unless 

you ask somebody if you can take their photo.  A 
street photographer’s eyes generally see it all in 
the busy world called life.  Good street photo artists 
see inspiration in street life; they see reflections in 
puddles, different colors in a crowd of people or even 
in a traffic jam, a reflection in a window, young lovers 
holding hands, a disagreement between a buyer and 
seller, children playing hide and seek, old and new 
intertwined together or a dog treeing a cat. 

Street photography has been a popular art form 
since the beginning of photography like street scenes 
were popular with painters.  In the late 1800’s and 
early 1900’s street photography was in vogue with 
the in crowds of New York, Paris, London, Moscow and 
almost every single city where a photographer could 
be found.  Street photography is still just as popular 

today as it always has been with many photographers 
only doing street photography and specialized street 
photography.  Street photography often means getting 
close to people, especially in large and crowded cities 
and how you handle yourself and your attitude will in 
a lot of cases determine how successful you are.  Act 
like some arrogant know it all jerk and you might as 
well stay home, but act decent, friendly and nice and 
people in a lot of cases will be more than willing to 
work with you.

Just what kind of camera do you need for street 
photography?  Most purists will automatically say 
DSLR, however, I tend to think the disadvantages of a 

DSLR outweigh its advantages 
for street photography.  Of 
course nothing can beat the 
DSLR’s wide angle and tele-lens 
capabilities, not to mention 
image quality.  Conversely, the 
DSLR’s disadvantage, and it’s 
a biggie, is that it stands out 
too much.  Sometimes in street 
photography you need to blend 
in and go unnoticed by most 
of the crowd, sometimes you 
will want to be noticed, but 
most of the time I like to be 
unnoticed until I’m ready to be 
noticed.  Your holding a DSLR 
camera with a lens as long as a 
meter with an opening as big 
as a dinner plate, you are going 
to be noticed by everybody 
and some of the attention you 
might get could be some you 
do not want.  I think a lens 
something like 55-200mm and 
a 24mm wide angle are the best 
for street photography.  You 

want a camera which has a good wide angle and good 
telephoto.  Travel light (in other words, no tripods, a big 
camera bag full of lenses, or other unneeded weighty 
extras).  My first choice for a street camera would be 
a good bridge camera with a good zoom range lens; 
my next choice would be one of the new pocket 
point-and-shoot cameras with good resolution and 
excellent zoom range.  The good thing about pocket 
point and shooters is nobody pays much attention to 
them; you’re just another 1 in a million tourist’s seen 
everyday in most cities all over the world.  Wide angle 
lens is very important for street photography, as some 
streets are very narrow and sometimes you will find 
it a challenge to include the whole of a building or 
complete street scene, so a wide angle lens can help 
you compose just the right scene.  A few extras and 
skills always comes in handy no matter the type of 

Ice sculpture’s at work sculpturing Big Ben in ice at Pushkin Square a couple of years ago.
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photography your doing, like having a LCD screen that 
tilts where you can hold the camera at waist level and 
take photos without people even knowing your taking 
photos and keep their natural expressions, or learn to 
shoot from the hip.  I just ordered me a new FZ50 with 
tilting screen.  Since then, I’m interested only in natural 
realist street scenes. I will sit the camera on my camera 
case on a bench and use the tilting screen to focus 
the lens as I need it, then I will attach a remote shutter 
release to my camera, then all I have to do to take a 
photo is press the remote shutter release in my other 
hand without touching the camera at all.  No fakery or 

sneakiness here, just honest down to earth true street 
scenes without anybody being upset that somebody is 
taking their photo or start posing because somebody 
is taking their photo.   Using the camera’s neck strap, let 
the camera hang from your neck, learn how to set your 
zoom, usually at the widest zoom, half press the shutter 
button to focus and take the photo.  But this type of 
shooting takes practice, you have to learn how to aim 
your camera without looking at the LCD screen or EVF, 
but this becomes very easy with practice.  Having a 
camera you can pre-focus will help you get shots before 
the persons expression can change or something gets 
away.  Pick a spot on the street, pre-focus on that spot 

and then when your target comes into range, snap the 
photo before they know what’s going on.

Street photography is fast photography, shooting 
from the hip like my distant cousin ‘Doc Holiday’ would 
do from time to time in the late 1800’s with pistols.  That 
is why point-and-shoot cameras are so good for street 
photography, especially some of the latest models.  I 
personally prefer using a bridge camera (a camera “in 
between” the range of a point-and shooter and a full 
blown DSLR), I can hide it fairly easy when I need to, 
(once inside a paper bag) yet still shoot out in the open 
without drawing too much attention to myself. There 
are many fine pocket point-and-shoot cameras today 
which come close to taking photos almost as good as a 
DSLR can and in my opinion these cameras, along with 
a few of the bridge cameras, make them perfect for 
street photography.  Though DSLR cameras are some of 
the best cameras made, because of the nature of street 
photography-fast shooting without being noticed, 
DSLR cameras just do not really lend themselves to 
this type of shooting for most people in my opinion, 
at least not for me.  The disadvantage of DSLR cameras 
for street photography is shots happen fast and you 
have to be ready.  You can not take time to change lens 
or change settings and expect everything to stop until 
your ready to take the photo, it just does not happen.  
Heavy camera, heavy lens, tripods etc… have no place 
in street photography.  Light and fast is the way to go, 
so you DSLR fans are at a bit of a disadvantage here.  

There are two ways to take street photos, indirect 
and direct. Some photographers prefer indirect, others 
direct and still others like me prefer using both ways 
to take photos.  If you’re a direct photographer, you 
do not mind people knowing that you are taking their 
photo; you often will approach people talk with them 
and ask if you can take their photo sometimes.  You like 
to be out in the open and do not mind if people notice 
you or not.  If you’re a direct photographer, unafraid 
and not shy, feel at ease with people seeing what 
your doing and are able to ask people if they mind if 
you take their photo, then a DSLR camera may serve 
you well if you let the camera not intimidate people.  
Indirect photographers tend to stand off to the side, 
in the shadows unnoticed by others around them.  
They tend to use tele-lens so they can get up close and 
personal from a distance without being noticed.  Both 
types of photography have their advantages and that’s 
why I use both.  

Most street photographers should look just like 
tourists.  Here in Moscow, that’s one of my favorite 
covers, to mix in with a bunch of tourists, except 
while they are shooting tourist sites, I’m shooting 
street scenes.  I always get a kick out of how some 
direct action street photographers make outlandish 

Just an unimposing shot taken of a lane in Moscow, I stood at the 
beginning of the lane and aimed my camera down the lane, most 
people could care less about me photographing the lane they were 
walking on.  Just stood out of the way, right in the open.
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statements how some indirect street photographers 
are somehow sneaky noisy perverts lurking around 
taking photos.  The only way to capture the true real 
life of the street is to photograph it with as few people 
as possible knowing your photographing the street, 
just two different styles of street photography that can 
work.  The true street photographer uses all types of 
photography to capture the scenes they’re looking to 
capture, but all this “I’m an honest photographer” and 
“you’re a sneaky photographer” attitudes that have 
popped up lately on some forums are just comical to 
me, especially for a type of photography that has no 
rules. 

Street photography is one of 
the ultimate photographic arts. 
Most of the rules, if not all of the 
rules, of photography are tossed 
into the trash heap when taking 
street photographs.  Some street 
photos can be blurry, noisy, bent 
perspectives, no rule of thirds 
or soft and un-sharp, the artist 
interprets their scene in many 
different ways.  True art has no 
rules and street photography in 
most case can not have any rules 
because things move pretty fast.  
You just can not stop everything 
on the street while you compose 
a shot or decide what settings to 
use in most cases.  Remember 
I said in most cases, when 
photographing something like 
architecture or posed street 
portrait shots, then you may have 
time to study your subject and 
follow the rule of thirds and other 
rules to your hearts content.  But 
most street photography is fast and you have to be 
ready for what ever comes along.  Life is not always 
so clear cut, sometimes it can be turned completely 
upside down and inside out, those who believe that 
you must always follow certain photography rules 
are just playing photographer so do not worry about 
rules when doing street photography, eight times out 
of ten they will not apply.  That blurry photo of nude 
joggers racing by in the early morning fog could be 
worth $1000s to a buyer of fine art street photography.  
What makes the street photo stand out is the photo 
artist’s interpretation of the scene, not because of 
using any so-called photography rule or using a fancy 
camera.  Never be worried about what pixel peepers 
say or think or anybody else for that matter.  You’re 
the artist and it is your creation.  The good shooting 
instincts of the photographer are 95% of what good 
street photography is about.

How I do my fine-art  street photography:

The two main types of street photography are what 
I call direct action and indirect action and these two 
types can further be divided into constant movement 
and waiting in one spot.  Direct action photography 
is when you’re out in the open taking photos and 
making no secret about it.  You approach people, talk 
with them, show an interest and ask if you may take 
their photo.  Sometimes when photographing street 
scenes, architecture, window reflections, you have no 
choice but to be direct with your photography.  The 
disadvantage of direct action photography is it makes 

a lot of people uncomfortable, even if they agree to 
pose for you; it’s a posed shot, not a real life street 
scene.  Good street photography is captures of real 
life, real street happenings, and real expression on 
passerby’s faces or two people discussing something.  
It is not easy for direct action photography to express 
the true charter of passerby’s, shoppers, and people 
of the street.  But you’ll be surprised at how people 
will react to a direct action photographer who shows 
confidence and genuine friendliness and interest.  
Successful direct action street photographers know 
how to approach people and know what to say.  Too 
many street photographers make the worse mistake in 
street photography, they follow somebody down the 
street just like a stalker, then they wonder why they get 
punched in the nose!  One of my favorite areas for direct 
action street photography is when I’m photographing 
artists on the street or in a park.  I will wait until 

Street scenes at night are one of my favorite types of photos, this Chinese restaurant on Moscow’s 
main street caught my attention one night.  Night street photography is one of my favorite types of 
photography.
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they take a break then I will strike up a conversation 
with them, maybe comment on their work.  As the 
conversation develops I will mention that I’m a digital 
art photographer, would they mind if I photograph 
them as they paint or sketch and that I will be more 
than glad to email them a copy of the ones they like, 
and I’ve yet to be refused.  Often I have already taken 
a few photographs of them working which I will show 
them.  Since I consider myself a digital artist, most 
artists are willing to let me photograph them, artist 
helping artist type of deal.   But sometimes indirect 
action photography really comes through better for a 
lot of street photography.  

Indirect action photography is where the 
photographer stands out of the way, maybe under a 
shade tree, in between two buildings, off to the side of 
a busy intersection or even on a bench in a city square, 
park entrance or pedestrian street.  Henri Cartier-Bresson 
one of the greatest modern street photographers 
used to hide his camera under his handkerchief when 
taking street photos, in the late 1800’s photographers 
like Matthew Brady who used big cameras often hid 
in wagons to do their street photography.  By using a 
tele-zoom, the photographer can capture things from 
afar.  I often prefer to photograph people on the street 
this way because they remain natural and show their 
true feelings where as when people know your taking 
their photo, they either get uptight or start posing.  
Often times the people I am photographing from 
across a street will notice me, so I’ll wave and they will 
start posing for me which I do not mind, as long as I 

was able to capture their natural 
state beforehand.  Lately on 
some street photography blogs 
and forums where a few street 
photographers feel that indirect 
action photography is not 
honest photography - somewhat 
perverted and sneaky as if the 
photographer is a peeping-
tom invading people’s private 
territory; I disagree. Indirect 
action photography is a way to 
capture the true expressions 
of the street and people’s 
true feelings, those who say 
otherwise are just wrong about 
capturing the real street scenes.  
Sometimes you have to be part 
of the scene in order to capture 
the scene, but a lot of times in 
order to capture the true scene 
you have to stay completely out 
of it.  I prefer my street portraits 
to be candied with my subjects 
looking exactly as they feel, two 

chess players concentrating on their game, not my 
camera, two passerby’s discussing a new modern art 
statue next to the Tretyakov Gallery I want to remain 
natural which would not happen if I were to take their 
photo by direct action.  There is a time and place 
for all styles of street photography and the street 
photographer who only limits themselves to one style 
and calls the others sneaky really are missing out on 
what true street photography is. 

When people are in public or in a public place 
where anybody or everybody can see them, they are 
fair game as far as photography goes, plain and simple.  
Often times I will show people the photo or photos I 
took of them, and never has anybody asked me to 
delete the photos of them that I took.  Many times 
people will notice that I’m photographing them and 
will be flattered and start posing for me like I’m a long 
lost friend.  So I disagree with street photographers 
who think that indirect action photography is invading 
people’s privacy or sneaky.  That would be true if I 
were sitting in a park and aiming a telephoto lens 
into somebody’s apartment window or a couple in a 
passionate moment, but photographing somebody on 
the street from afar, there is nothing wrong about that 
as long as they are in public and in a public place.  

Candid photography is best described as un-posed 
and unplanned, immediate and unobtrusive. This is 
in contrast to classic photography, which includes 
aspects such as carefully staged portrait photography, 
landscape photography or object photography. 

Street artists or more correctly art students at work in St. Petersburg, street artists and art students are 
one of my favorite subjects to photograph, when they find out that I’m a digital artists they become 
very friendly and we always end up talking about art, school and different things.
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Candid photography catches moments of life from 
immersion in it and this can only truly be done from 
a far sometimes, often without the subject even 
knowing they are being photographed.  The events 
documented are public street scenes, not private, they 
involve people in close relation to something they are 
doing, or they involve people’s relation to each other 
on the street.  Indirect action street photography is 
just that, documenting life as it actually happens. No 
poses....just reality...the moment.  Direct and Indirect 
action street photography are just two different styles 
of street photography, “to each their own.”  There is 
a place and time for each style of photography and 
knowing when to use each one is a part of being the 
successful photographer.  Any photographer who 
chooses to limit themselves to only one style really is 
handicapping themselves and their photography in 
my opinion, every photographer has their own style 
and use what works for them.

Street photography also involves both movement 
and stationary photography.  It really depends on what 
street I’m on if I’m moving or staying pretty stationary.  
If it’s a street that’s new to me, them usually I will walk 
slowly down it exploring it and its side streets, doing 
what I call street walking photography, pausing here 
and there to look everything over.  If it’s a street I know 
very well or one of my favorite photography streets, 
then I usually find a place to sit awhile and watch the 
world go by, of course it depends on just what type 
of street it is and what I’m looking to photograph.  If 
its people, then I generally stay in a square, park or sit 
on a bench on a pedestrian street.  If it’s not people 
I’m photographing, then I generally slowly move down 
my target street, pausing here and there while looking 
things over.  

Always stay prepared to take a photo or you will 
regret it.  I remember a couple of years ago there was 
a popular commercial on TV here which featured a 
motorcycle gang of nuns.  They were just like the “Hell’s 
Angels” except they were nuns dressed in nun’s habits, 
maybe they were “Heaven’s Angels” instead..  Well I 
just had gotten off the bus and was walking down the 
street, had my camera hanging from my neck, but it 
was turned off. All of a sudden I heard motorcycles so 
I looked at the corner and there was this motorcycle 
gang of nuns, popping wheelies and laying rubber with 
their nun’s habit hoods flying like tails behind them as 
they took off when the red light changed.  I missed a 
great shot because I was not ready, so stay ready when 
doing street photography because things happen fast 
on the street and you never know just what you may 
see or come across.  You have to always be prepared 
for the unexpected, especially if you’re on the move.

Here are a few tips for street photography that 
work for me to help you get photos that express the 
real soul of the city.  Of course every person has their 
own style of photography, some like direct action 
others like indirect action and still others like me enjoy 
using both styles.  Street photography will open up a 
whole new world for the photographer and if you do it 
right you will find yourself capturing the real story of 
life, give it a try I’ll think you’ll love it.

1) Play it safe:

Be careful and always aware of your surroundings.  
In Moscow for example, some dishonest people will 
offer to take your photo in front of major tourist sites 
with your camera. You give them your camera and get 
into a pose.  They then take your photo and demand 
payment before they give your camera back or they 
just run off with your camera.  Sometimes people with 
cameras are considered easy targets or tourists with 
money.  You have to be safe and aware of tings going 
on around you, only cross the streets in the proper 
places, do not block doors or traffic (both foot and 
vehicle), and do not argue with people, it’s not worth 
it.  If questioned by anybody be honest with them; 
I’m a street photographer or digital art photographer, 
they might take what you’re doing as a compliment 
and be flattered that your taking their photograph.  
You should think about how you will handle problems 
before you even leave home, how you will handle the 
neighborhood busybody who thinks it’s their right 
to stick their nose in everybody’s business, every 
neighborhood has one.  How will you handle the 
neighborhood street bully, an over zealous police or 
security guard, you need to think about these problems 
which could arise along with your safety before you 
even step out of your door, “Always Be Prepared” as US 
Boy Scouts used to say.  

I also love taking photos of people taking photos and being 
photographed by another person besides me. I always find it interesting 
even though they are posing for another person, they are not posing for 
me, so it is true to life..
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2) Use the crowds to your advantage and blend into 
the crowd:

  In large crowds people generally do not notice other 
people really.  Learn how to stand next to buildings 
or the street curb to take your photos.  Sometimes 
you can stand in the middle of the sidewalk, but you 
have to be very careful.  Nothing stands out more 
than a photographer blocking the flow of traffic and 
store owners sure will not be fond of you standing in 
their doorways blocking customers from entering or 
leaving.  You’ll find that 99% on the street are too busy 
to worry about you taking their photo, it should be 
obvious who to approach and who not to approach.  
Use your common sense and look for the best spots 
to photograph from with a good view, yet does not 
block the flow of traffic.  Act as if you belong there, 
but do not overstay your welcome, get your shots and 
move on.   Always be on the lookout for good shooting 
positions, maybe you spot a building with a elevator 
outside the building with glass walls, may be worth a 
try to see if you can take  a short trip on it to the top 
floor and back down for some quick shots.  Maybe a 
hotel where you can go to the top floor and take a few 
shots or an outdoor stairwell, always be on the lookout 
not only for shots, but for shooting positions. 

3) Do not be afraid of sometimes photographing 
from a distance:

Photographing from the distance captures the true 
life, the true feelings, and the true expressions.  If you 
choose to use a small tele-converter, then find a good 
location to photography while stationary.  Sitting on 

a bench in a park or square or from a 
balcony can provide some great street 
portraits.  One of my favorite places to 
take street portraits is Lavrushinskiy 
Lane; A pedestrian lane in Moscow 
where the Tretyakov Art Gallery 
is located.  The lane is lined with 
benches and modern art and I love to 
sit on a bench on this lane and watch 
people discussing the modern art and 
photograph them.  I’m right in the 
open, not hiding from anybody and 
many times they will notice that I’m 
photographing them and I will show 
them the photos I took.  Always be 
extra friendly, even when you do not 
have to be.  I enjoy sitting on a bench 
an aiming my tele-photo lens down 
the street to catch a couple of people 
hotly discussing this modern art 
statue, this is true to life photography, 
not sneaky photography.

4) Timing is everything in street photography:

Its not using a fancy DSLR or a small unnoticeable 
point and shooter, it is getting your timing right and 
that is most likely the number one reason why most 
street photographers fail, they just can not press the 
shutter release at the right time.  In direct action street 
photography, this is not as much of a problem since 
most shots are set up before the shot is taken, but in 
indirect action street photography where your trying 
to take the most natural looking photo, timing is 
everything and pressing the shutter release at just the 
right moment is not as easy as it looks.  Pre focusing 
your camera helps greatly, choose a location, pre-
focus your camera, leave your finger on the shutter 
button half pressed so you do not lose the focus and 
when your ready to take the photo, your all set.  Just 

Be ready to capture the action at any moment!

St. Patrick’s Day parade on New Arbat Street in Moscow a couple of years ago.
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raise your camera, fully press the button then lower 
your camera all with in a couple of seconds, before 
the person your photographing knows you took the 
photo.  This is one reason I bought the FZ50 camera, 
it has great manual controls along with a great manual 
focus lens.  I can set this camera up exactly as I choose, 
then all I have to do is press the shutter button; no more 
fooling around with focusing, it’s already done and set.  
Taking time to focus is the biggest killer, your subjects 
sees what your doing and their expression changes 
sometimes.  You have to believe that you have an eye 
for the extraordinary found in the ordinary. That’s what 
I put most of my efforts. What camera is best or what 
settings to use is of non-importance and can only take 
you so far. Patience and the will to see people as people, 
not strangers who are only extras on your stage is what 
you should be thinking about. 

5) Know your rights:

Photography still is not illegal yet in most cities 
and countries; every now and then you’ll run into a 
busybody who thinks negatively of you photographing 
children, or an overzealous guard who mistakes you 
for 007 of the terrorist world.  It pays to have a small 
card with your rights on it (do a Google search on 
“Photographer’s Rights Document for the city you’ll be 
shooting in).  For example here in Moscow I have small 
half sheet of paper printed with the rules and rights 
of photographers in Russia, if I ever have any trouble, 
(never have knock on wood)  I’ll just take it out of my 
camera case or pocket and show it to who ever has a 
problem with me taking photos. 

6) What makes a good street shot?

Most photographers, let alone the street 
photographers never even think about art.  What 
makes a good photograph, why are you taking this 
photo, why did it catch your attention, did you focus 
on its strongest points so others will recognize why 
you took the photo?  Festivals, parades, protests, block 
parties or great things to photograph on the street, 
where things are generally pretty busy so people are 
not really paying attention to photographers.  Know 
about the area you are taking photos.  When you go out 
on a shoot, you should have a certain theme in mind, 
that is not to say that you can not shoot what you see 
that interests you, but it helps to have thought about 
a certain theme and play close attention to it, whether 
it be churches, traffic (pedestrian or vehicle), certain 
types of buildings, art work, artists, pretty girls, maybe 
people’s watches or shoes.  When people ask what you 
are up to, why did you photograph them, you can be 
honest and say, you’re a digital artist and your cloths 
matched my theme today “Colorful Dress” and most 
people will not only understand, but be somewhat 

flattered.  Pick a theme and try and stick to it.  Make 
photos which make words pop into the viewer’s head.  
Take time to scout out your street first, find the best 
spots to take your street photos from. 

7) You should understand and respect that 
not everybody wants their photo or property 
photographed:

Sometimes people will give you dirty looks, 
“another pesky tourist” type look.  Accept that fact, but 
always be friendly and try to be understanding.  Never 
hurts to apologize and say you’re sorry if you bothered 
anybody.   Learn to assess the situation, if the person 
looks as its better to ask first, and then ask first, if not, 
then shoot your photo.  You should concentrate on 
capturing the true spite of the street, its people, the 
events, happenings, everything on the street in its 
natural form unaware that there is any photographer 
nearby and indirect photography is just about the only 
way to do this.  You want to capture not only the day to 
day actions of the street, but also the unique actions of 
the street and people.   

Street photography is not always about people, this is one of my 
favorite street photos of  aside street completely empty of people, but 
this church built in the 1600’s stands out doesn’t it?
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8) Do not forget there is much more to street 
photography than just people:

Street photography forums seem to concentrate 
only on the people angle, there is much more to street 
photography than just people.  Streets are a cities soul 
and veins that carries its blood.  Look at a street at night 
when nobody at all is out, street wildlife, architecture, 
construction, window washers, street cleaners, painters, 
vehicles on the street, gardens, statues, memorials, day 
to day street activities, social ills, or news events.  It’s 
a whole different world for the photographer on the 
streets and it can be the most difficult photography 
that you’ll ever try doing.  Plan everything first and 
know exactly what your going to photograph, what 
you will need and how you will do it.  Learn when to use 
what style of street photography and just as important 
when not to use a certain style.  Learn to see more than 
simply your immediate subject - always be aware of its 
relationship to the background, to incidental elements, 
to forms and geometry within that scene; and look at 
the work of the masters posted all over the Internet. 
Remember that if street photography was easy, then 
everyone would be doing it all the time, but they are 
not.  

9) Be respectful for what you are shooting:

For myself, there are certain things I refuse to 
photograph; beggars, homeless, unemployed, drunks 
and other social ills.  Maybe if it would help make a 
change I would, but I to try and benefit from others 
bad fortune, and I will not do that.  Not everything on 
the street is good and I’ve seen my share of bad things, 
a lady hit by a car, a DOA (dead on arrival) several times, 
drunks passed out on the street and the elderly begging 
on the street.  I have too much respect for people to 
photograph things like that.  Of course that is only 
my personal belief and other photographers may feel 
different and that is fine.  Also be aware of where you 
should go and where you should not go. Every city has 
a bad section of town where drugs are sold, gambling, 
street walkers, gang hang-outs; if you’re smart, stay 
out of these areas or you could end up in extremely 
unsafe situations. Also, beware of photographing 
children. Sadly in today’s world too many sickos are 
running around photographing children.  You may 
wish to photograph groups of children under certain 
circumstances, but never photograph single children 
even with their parent’s permission unless you’re in the 
portrait business.  It’s not hard to use a little common 
sense!

  
Here are some interesting links and information on 
street photography:

I still consider street photography to be real 

photography in that there is no other photography like 
it.  It makes no difference what streets you photograph 
on, I think the streets of your hometown will be the 
best until you learn how to street photograph well 
and good.  Like I said, I think taking natural photos are 
the best, asking for permission just does not give the 
natural look to me.  I want my photos to be natural 
and show real life, therefore I generally use indirect 
action photography the most, but that is up to you the 
photographer to decide what is best for you.  You’ll 
notice that I agree with some of these photographers 
and disagree with some; photography is after all the 
artist’s choice of how they want to create the photo.

Candid/Street photography - A few tips:
A pretty nice link and user posts for street portrait 
photography from one of the stock art agencies I use.
http://www.redbubble.com/people/deckham/
journal/979733-candid-street-photography-a-few-
tips  

Renaissance Street photography
http://yeskarthi.wordpress.com/2008/02/13/street-
photography/

Street Photography for the Purist by Chris Weeks                  
In my opinion this is absolutely the best free ebook on 
street photography that you can download, it takes 
you through page 300 something before Chris Weeks 
writes anything about his style and techniques of street 
photography, but this really is an excellent book to add 
to your photography ebook library.  This is what true 
street photography is all about.
http://fc08.deviantart.com/fs11/f/2006/227/e/2/
street_photography_for_the_purist.pdf

The Art Of Non-Invasive Street Photography - by 
Henri Bauholz
This is a pretty good article with a few tips on street 
photography
http://www.bravenewtraveler.com/2007/12/06/the-
art-of-non-invasive-travel-photography/

Guide to Street Photography  - by Margaret Brown 

http://www.photoreview.com.au/tips/shooting/
guide-to-street-photography.aspx  
Some very good short articles on street photography, 
this author has written several which also include  
Street Photography Guidelines:

http://www.photoreview.com.au/tips/shooting/
street-photography-guidelines.aspx

This article and all photographs contained are Copyright © and courtesy of Jon Ayres. Please contact the author directly with any questions.
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Photography 101
Each issue of PhotographyBB Online Magazine will bring you helpful tips and 
tutorials on how to get the most of your digital camera and equipment. We’ll 
cover camera techniques, principals of photography, digital photography 
issues, and how to get the most from the dreaded manual-mode! 

With all the thick plate-glass, iron bars and wire 
fencing, photographing animals in the zoo can 
be challenging but by no means impossible. 

Here I am going to guide you through working around 
the obstacles, which can sometimes get in the way 
between your camera and the animals.

A good start for improving your zoo photography 
is the use of an SLR with a good zoom lens or prime 

lens of between 200mm and 400mm, remembering 
that the more zoom you have the ‘closer’ you will get 
to the animals. 

The main aim of this tutorial is for me to help you 
to achieve excellent photography of the animals in a 
zoo. By the time you are finished, the enclosures will 
have disappeared and the animals will be in the wild 
again. No, I am not asking you to break locks or knock 
fences! With a few simple steps, you will achieve results 
that will remove almost completely, the ‘zoo’ aspect 
of the photographs you produce and bring you on a 
virtual safari.

The first step of course, is setting up your camera. 
Preferably, you should manually focus the subjects (I 
will explain why later in this tutorial). Depending on 
the weather, set your ISO speed accordingly: A bright 
sunny day works well between 100 and 200 ISO, and 
overcast days require a faster (higher) ISO. Therefore, 
between 200 and 400 ISO should work for you nicely 
for a dull day.

Next, switch off your flash. You may startle some 
animals and flash photography through glass just does 
not work in any environment. It is also a good idea to 
shoot RAW for best detail and colour preservation. 

Lining up the subject:

Good framing is vital; do not just shoot at random. 
Think through thoroughly what you want out of 
each image, as shooting with haste only ends up in 

BEHIND BARS: YOU’RE GUIDE TO BETTER ZOO PHOTOGRAPHY - By Kenneth Fagan

With summer just around the corner the warmer weather has us all outside and wanting to go places, and what 
better place is there to go for a day out other than the zoo or wildlife park. The zoo is a magical place to visit 
for a day even if you do not have kids on tow. The local zoo or wildlife park is also a wonderful place to take 
photographs, with all the varying manmade landscapes and vast array of flora and fauna, which otherwise most 
of us are unlikely ever to see.
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disappointment. Of course, it is not always going to be easy to get the perfect shot. In fact, the chance of you 
catching a five hundred pound lion bounding around in its enclosure is very slim indeed. Therefore, you have to 
make do with the situation on front of you and make the most of it without compromising the final product. 

Many people have a habit of just shooting straight out, meaning a constant theme of downwards style 
photography. Try as best as you can to be at least eye level with your subject. Although this may be difficult on 
some occasions, but it will greatly improve the result of an image. Another aspect to be wary of is focus and depth 
of field (recall our first tutorial on f-stops in Issue #1). The main focal point in any image with living creatures is the 
face, particularly the eyes. A sharp tail and a blurry pair of eyes hardly make for pleasant viewing. Be particularly 
wary of this on duller days where you may have your aperture wide open at f8 or f5.6. A shallow depth of field is less 
forgiving for selective focus than smaller apertures like f22 or f32.

Should you be having trouble framing a particular animal, you can create a frame within the image and crop it 
later. Look at the before and after of the lion below. He was sleeping in his shelter for most of the day. I waited for the 
right moment for the lion to face directly towards me. You have to be patient, as in this instance I was waiting fifteen 
minutes for that right moment. Let’s have a look at this example below:

Here we see where the framing was originally compromised slightly. Afterwards in the post process I cropped 
tightly around the face, straightened the head a little, and made some simple adjustments using curves resulting in 
a dramatic and powerful image

Another example of waiting for the right moment is shown (on the following page) in the image of the two 
Humboldt Penguins. The penguins were shouting away raising their bills into the air. Framing was quite simple; it 
was just a matter of waiting for the right note.

Before: Original photo of the lion. Looks nice but lacks interest. After: Same photo cropped, rotated slightly, and contrast adjusted.
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As I mentioned earlier focusing through glass can 
be particularly tricky, particularly if is it scratched, dirty 
or tinted. If you set your lens to auto-focus, it will try 
to focus on the glass as it will have picked up on the 
dirt. For this reason, manual focus is preferred as you 
can then focus through the glass. The next problems 
with glass are glare and reflections. To avoid this, get 
the lens as close as possible to the glass, which will 
block out most of the light on your side off the glass. 
The image of the lion (shown earlier) was manually 
focussed through relatively clean glass, and as a result, 
the glass has completely disappeared in the image. 

In the profile shot of the tiger (top-right photos), 
you see in the first image the effect that a dirty pane 
of glass can have on an image. It was not possible to 
get past the cloudy effect while taking the picture as 
the tiger was in close proximity to the glass so it was 
unavoidable in this instance. I cleaned up the image 
to good effect by reducing the hue and increasing 
the saturation, as well as increasing the contrast. This 
reduces significantly the original hue of the dirty 
glass.

Let’s have a look at the following before and after 
example, of how some simple processing can help.

Creating Impact:

The more impact you create in an image the more 
appealing it will be to look at. Good aesthetics in a 
photograph is important to keep people interested. 
The quantity of frames you shoot is much less 
important than quality. It is much better and a lot more 
enjoyable to look at five to ten high impact photos 
than fifty or sixty average to poor images. Choose the 
ones that instantly draw your attention. The images 
that instantly draw your attention are the ones that 
will create impact. There are no rules, you do not have 
to work on all your images. Enjoy working on the ones 
you like and forget about the rest; shuffling around 
with stuff you do not like is no fun!

Identifying a good-looking image is easy, but can 
be extremely meticulous. It would be helpful to get an 
honest friend to assist you in picking the best ones if 
you are having trouble. When creating a high impact 
image, there are a few things you will want to work on, 
which are as follows:

Waiting for the right moment to capture the Humboldt Penguins.

Before: Dirty pane of glass makes this shot hazy and dull.

After: Some simple post-processing makes this image quite striking.
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Eyes:  If you have a full frontal headshot of an animal, 
the eyes must be sharp. In reality, eye contact is 
important. This is the case in photography too.

Posture:  When you do a portraiture of a person, you 
ensure that the subject is not slouching or sitting/ 
standing in an awkward manner. The same rule applies 
to animals. It can be difficult when you have no control 
over the animal’s movements. It is just a matter of 
waiting for the right moment when the animal is in 
a forward stride or in a position that you feel would 
create the biggest impact.

Exposure: Unsightly highlights can greatly reduce 
the impact of an image. It is important to watch your 
exposure meter, adjust your f-stops, and shutter speeds 
accordingly. At the same time, do not be afraid to do 
some experimenting with your exposures.

Problem Enclosures:

The enclosures which can cause the most problems 
are the chain link or wire fences. You must manually 
focus through the wire fencing. The biggest problem 
is the blurring, which is caused by the fencing in the 
image. In the following photographs of the wolf, the 
wire fencing was a big problem. With very little in 
the way of vantage points, getting the right shot was 
difficult. The blurred lines of the wire fencing were 
impossible to avoid. Had the wolf been a greater 
distance from the fence there would have been less 
likelihood of the fence appearing in the image. The 
lines can be removed from the animal in Photoshop (or 
alternative software) using the clone stamp or healing 
brush tool. By blurring the background a little more, 
and making it a little darker, the lines no longer have as 
much of an impact on the quality of an image.

There is also no way of avoiding the chunky nature 
of an iron bar fence. The only method to keep them 
out of the way is to try to shoot between them or over 
them. Otherwise, they do not cause a major problem 
except they do look obtrusive in a photograph. In that 
case, some tight cropping can give greater appeal.

Before: Notice  how the chain link fence was in the way on this shot?

After: Wire fence “cloned out” and background darkened.
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This article and photographs contained are Copyright © and courtesy of Kenneth Fagan. Please contact the author directly with any questions.

Ethics:

Photographing animals in the zoo can be a lot of 
fun, and very interesting. It is however, important that 
you don’t get too carried away and start pushing your 
way through the crowds to get ‘That Shot’. You will not 
only look silly, but you will surely frustrate the other 
guests. 

Do not feed the animals to get their attention, 
most of them are on strict diets so do not be the one to 
make them sick it is not worth a good shot.

If possible, leave your tripod at home, particularly 

on the zoos busier days. Tripods are an excellent 
tripping device for people around you and could prove 
dangerous. A monopod would be sufficient in this case 
if you need some support. 

Finally, it is important to realize that, depending 
on the weather conditions, some animals and birds 
may not be very active. Most creatures tend to ‘laze’ 
around for most of the day to preserve there energy 
reserves. This is a natural survival instinct from their 
wild ancestors, which protects them in times of prey 
shortage, and intense heat or extreme cold. So bear 
this in mind when you wait for them to move because 
they may not budge for hours. Patience is the key to 
successful zoo photography. It is a lot of fun but it 
will not always go your way. It is all down to how the 
animals are on the day and it’s out of your control. So 
make the most of it, and most importantly – Have fun! 

A Red Panda relaxing on a tree branch.
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Photography Around the World
PhotographyBB Online Magazine is pleased to launch our first issue with a 
fabulous and stunning photo-tour of one of the most fascinating cities in 
the world - Moscow. Jon Ayres takes us on a streetwalking tour of the city, 
with some interesting historical facts and of course, amazing photos!

Photography Around the World

In our fourth issue of the PhotographyBB Online Magazine, Euclid Seeram 
gives us an fascinating look at the beautiful city of Vancouver, Canada - A 
culturally diverse metropolis and home of the 2010 Olympic Winter Games. 

WELCOME TO VANCOUVER-HOST CITY OF THE 2010 WINTER OLYMPICS  - By Euclid Seeram

Vancouver is one of the most vibrant, exciting, scenic, and liveable cities in the world, located in beautiful British 
Columbia, Canada. The name Vancouver is now at the center of world-wide media coverage advertising that 
this magnificent city will be hosting the 2010 Olympic and Paralympic Winter Games from February 12-28, 

2010 and March 12-21, 2010, having been selected by the International Olympic Committee in July 2003.

The overall goal of this brief article is to provide you with a photographic glimpse of the spectacular city of 
Vancouver. 

As noted on the Vancouver website (http://www.vancouver.ca)  “Vancouver is a city with many diverse types of 
communities. The city is renowned for having created ways for all citizens to celebrate who they are, and participate 
in every aspect of life in Vancouver. Vancouver is home to a multitude of cultures and languages from around the 
world. The city of Vancouver values this diversity, and considers it a source of our strength, vitality, and prosperity”. 

The Downtown Vancouver skyline as seen from Stanley Park. (Image courtesy of David Seeram)
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The diversity of Vancouver is reflected in the various cultures seen in the 
images shown above.

The history of the city can be traced back to 1792, 
when the English naval Captain George Vancouver 
explored this region. In this regard the vancouver.ca 
website adds a little more perspective and tells us that 
“Vancouver was founded as a sawmill settlement called 
Granville in the 870s. The city was incorporated in 1886 
and renamed after Captain Vancouver.” More detailed 
information on the history of Vancouver from 1792 to 
2004 can be found at:

http://www.vancouverhistory.ca  

for those who are interested in details. Today, Granville 
Island is a colourful tourist attraction where musicians 
perform outdoors and where restaurants, pubs, and 
various galleries cater to the needs of not only tourists 
but those who live here as well.

Granville Island today where the market is one of its central attractions 

A spectacular feature of Granville Island is the 
market place rich with locally-grown fresh fruits, 
vegetables, and bake goods, flowers and all varieties 
of coffee.

Visitors to Vancouver are usually focussed on seeing 
the most popular scenery, and the new architecture of 
the inner city’s buildings and parks, museums, beaches, 
aquarium and totem poles to the bridges, beautiful 
gardens and mountains that the city has to offer. 
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An aerial view of Vancouver sets the overall 
tone of the layout of this majestic city where several 
pieces of land masses are connected systematically 
by suspension and other well-engineered bridges. 
This spectacular aerial photo of Vancouver shows the 
North Shore mountains in the background together 
with one of the famous landmark, BC Place Stadium 
where 60,000 fans can enjoy one of the popular 
national Canadian sports, football. The spectacular and 

glorious Vancouver skyline shows the relatively new 
architecture in recent urban renewal ventures

It is a well-know fact that people move from all parts 
of Canada and elsewhere to Vancouver because of its 
year-round mild climate. On sunny days, other enjoy 
the beaches, jogging, cycling, golfing and kayaking at 
ground level, and skiing at higher elevations all in the 
same day.

Spectacular view of the Vancouver’s skyline. Recreation activities in beautiful Vancouver.
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In 1986, Vancouver hosted Expo 86 World Fair, and 
several new buildings featuring unique architectural 
designs were constructed to accommodate and 
entertain people from all over the world. Today some 
of these structures, perhaps most notably, Canada 
Place, commonly referred to as Vancouver’s Trade and 
Convention Center survived, and it is at the center of 
tourism. A major design feature of Canada Place is 
its five white Teflon-coated sails that are part of the 
roof construction. Furthermore the decks of Canada 
Place provide visitors with a spectacular views of 
the majestic, luxury and massive cruise ships that 
frequently dock the harbour, enroute to places such as 
Alaska, for example.

For further enjoyment, the city offers other options 
for walks in busy city streets such as the renowned 
Robson Street and Gastown area, and subsequent 
relaxation on the lawn of the Vancouver Art Gallery

Visitors can “shop ‘til you drop” or just enjoy the 
city’s unique architecture reflected in the recently 
erected Vancouver Public Library which attract 
thousands of visitors everyday not only to browse its 
book and magazine collection but also its historical 
photographs, and children’s library. In addition, there 
is the well-known Vancouver Center for the performing 
arts for those who enjoy the varied cultural activities 
featuring talented performers from all over the 
country.  

Skiers can enjoy a glorious view of Vancouver.

Canada Place is its five white Teflon-coated sails that are part of the 
roof construction where luxury cruise ships come and go.

Above: Gastown Steam Clock, Robson Street (Downtown Vancouver) 
and the Vancouver Art Gallery.
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Other exciting places for both young and old 
visitors to Vancouver include art galleries for art lovers, 
the Vancouver aquarium and the city’s more than 
200 beautiful gardens, such as the larger and popular 
Queen Elizabeth garden which features the Bloedel 
Floral Conservatory and which displays not only a wide 
array of luscious tropical plants, but tropical birds that 
fly freely in the conservatory’s dome. Other gardens 
include the Vandusen Botanical Gardens, Nitobe 
Memorial Garden, Dr Sun Yat-Sen classical garden

Vancouver’s museums are many, however most of 
visitors frequent the museum of anthropology which 
contains a wide variety of artefacts. The MacMillan 
Space Center and Museum is also another popular 
especially enjoyed by all because of its location 
where one can view the water and densely populated 
downtown Vancouver.

Photo of Van Public Library. 

Vancouver Center for the Performing Arts.

Dr. Sun Yet-Sen chinese classical gardens.

Museum of Anthropology contains over 12,000 First Nations artefacts.
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It is not within the scope of this article to provide 
a full description of the myriad of spectacular scenery 
and architecture of beautiful Vancouver however, the 
remaining photographs illustrate the grandeur of our 
magnificent city, home of the 2010 Winter Olympic 
Games. This event is marked by the use of the inukshuk, 
created by the Inuit people of Canada and first used as 
a guidepost to provide direction for those travelling 
in Canada’s vast northern country. The inukshuk was 
selected (from more that 1600 entries) as the symbol 
of the 2010 Olympic Games. The symbol extends a 

warm and friendly welcome to the people of the world. 
Welcome to Vancouver, the most vibrant, exciting, 
scenic, and liveable cities in the world.

ACKNOWLEDGMENT:

Euclid would like to thank Susan Graham, Manager, 
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The MacMillan Space Center

All images in this article are Courtesy of Susan Graham, Manager, Convention Services, Tourism Vancouver. Article written by Euclid Seeram. 
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A Photo filter is a device which is attached to 
the front of a lens to balance the colour of the 
ambient light bouncing off the subject(s) in an 

image. There are many different varieties of filters, 
each one has a purpose and each one works to good 
effect under different light circumstances. In addition 

to balancing various lighting conditions, filters are 
especially useful in acting as a protector for your lens. 
It would be much less expensive to replace a scratched 
filter, than a scratched camera lens. Let’s have a look at 
how filters work, and the various functions of some of 
the different filters available.

Choosing the Right Accessories
With all of the photography gear on the market today, it’s difficult to 
determine which accessories are right for you, and what to look for once you 
decide on an accessory. In this ongoing segment, we’ll examine the things 
you should look for when choosing photography accessories, and help you 
to make an informed decision based on your photographic needs.

PHOTO FILTERS: A GLASS ACT - By Kenneth Fagan

Have you ever wondered why the photographs you took at the beach on the hottest day of the year look cold? Or 
your Landscapes always have the sky blown out. With the use of filters the problems of colour casts can be put 
to one side and give your pictures a whole new lease of life.
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The colour of the light is known as the colour temperature. Colour temperature is measured in Kelvin (K). Each 
Light source whether it is natural or artificial has a certain colour temperature. In the chart below, you will see the 
various different sources of light and their colour temperature range.

In the colour temperature chart shown here, the lower 
the colour temperature, for instance the cooler the colour 
temperature, the warmer the light emitted is. The higher 
the colour temperature is the harsher and brighter the 
light will be. The light from a candle flame or a tungsten 
lamp is yellow. The light emitted from the sun is white. 
White is made of seven separate colours; red, orange, 
yellow, green, blue, indigo and violet. The best example 
of this is a rainbow where the sun shines trough water 
droplets and splits the white light into the seven colours 

of the visible spectrum. Outside of the visible spectrum is infra-red and ultra violet light. With so many varying light 
conditions it is necessary to avail of filters as they balance the light as well as improving and enhancing the overall 
appearance of an image. 

I have compiled a list of widely used common filters as well as some lesser used special effect filters. With each 
filter I have explained their uses and added a sample image to help you get a better idea of how each filter works. 
You may wish to zoom the following pages in to 125%-150% to get a good look at the before/after photos.

Polarizer Filter:
Polarizing filters are very useful for both colour and black and white photography. Reduces glare and reflections 
in water and increases the contrast of an over all image. Polarizer’s are particularly useful for increasing contrast in 
landscape photography. Without a Polarizer on a bright sunny day, trying to get a good exposure of the sky when 
you don’t want to underexpose the rest of the image with a wide aperture can be quite difficult. A polarizer will give 
an image more punch and better colours without nasty haze and reduce the risk of overexposure. When using a 
polarizer you may have to increase your aperture by one or two stops. (E.g. without polarizer f22 1/125th sec, with 
polarizer f22 1/60th or f16 1/125th sec).

Flame 1700-1900K

Sodium 2000K

Tungsten Lamp 2800-3300K

Studio Lighting 3300-3500K

Fluorescent 4000K

Daylight 5000-6000K

Without Polarozer Filter With Polarizer Filter
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U.V. (Ultra Violet) Filter:
Ultra Violet filters to the naked eye appear to be clear glass filters. They reduce the amount of UV light entering the 
lens. This increases the contrast and reduces haze. Otherwise when using UV filters they do not affect the exposure 
times. Not only are UV lenses useful for reducing haze but many photographers use them to protect the glass on the 
lens, to protect against dust and scratches. 

I.R. (Infra Red) Filter:
Infra-rd filters are more commonly used for black and white photography, Infra red sensitive film is used in conjunction 
with the infra-red filter. As the name suggests these filters blocks out the majority of light in the visible spectrum 
creating a surreal effect of darkened highlights and lightened shadows with intense contrast 

Without UV Filter With UV Filter

Without Infra Red Filter With Infra Red Filter



Pa
ge

 29

PhotographyBB Online Magazine

Blue / Cooling Filters:
Blue or Cooling filters are used mainly for situations where tungsten lighting is in use. This is to remove the yellow 
hue associated with tungsten lighting and gives the impression of daylight conditions. There are various grades of 
blue filter each one is used depending on the original colour temperature.

Warming Filters:
Warming filters are typically light orange in colour. Like cooling filters, they are available in various degrees of 
strengths. Warming filters are useful for removing the blue cast caused by clear skies on a bright sunny day or to 
give the effect of the use of tungsten lighting in the photograph. 

Without Cooling Filter With Cooling Filter

Without Warming Filter With  Warming Filter
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Neutral Density Filter:
Neutral Density filters work by darkening an overall scene of an image by one or two stops (depending on the 
strength of the filter used). These are useful for very bright conditions such as snow on a bright sunny day. Allowing 
for greater control on exposure in situations where you may want a slow shutter speed but the bright conditions do 
not allow it. The neutral density filter can allow the photographer to open up the aperture by one or two stops or 
more, depending on the strength of the filter.

Magenta Filter:
Magenta filters are used in situations where fluorescent lighting is used. Fluorescent lighting tends to have a green 
colour cast in a photograph. The magenta filter counteracts the green cast and gives the impression of daylight. 

Without Neutral Density Filter With Neutral Density Filter

Without Magenta Filter With Magenta Filter
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Special effect filters are another group of less common but widely used filters, with digital photography the need for 
these filters has decreased significantly. With digital photo editing software the call of today, the effects once only 
achieved with on camera filters can now be achieved at your desk with just the click of a button. The same applies to 
the filters I mentioned earlier but to a lesser degree. Colour temperature can be adjusted on most DSLR’s today but 
filters are also still widely used.  Here are just a few special effect filters that are available on the market today

Diffraction Filter:
Diffraction filters are made of clear glass with fine lines engraved into the filter. The fine lines separate the light into 
the seven colours of the spectrum on the highlighted parts of an image.

Without Diffraction Filter With Diffraction Filter

Star Filter creates a “starburst” effect on bright highlight areas.

Star Filter:
Star filters are used to create a sparkle 
effect around highlighted areas of 
an image, typically from lights or 
highlights from the sun shining on a 
reflective surface. These filters work 
particularly well on shots of the sun 
(as shown here) or on shots of city 
lights at nighttime.
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Diffusion Filter:
Diffusion filters soften the overall appearance of an image; it doesn’t mean that it causes the image to be out of 
focus. It just diffuses the light reflecting off the subject giving a soft glowing effect.

Gradual Filter:
Gradual or graduated filters consist of a coloured tint graduating from darkest at the top to clear at the bottom. 
There are many colours of gradual filters to choose from and are ideal for landscape photography. Gradual filters add 
an extra bit of punch to clear skies or sunrise and sunset.

Most filters are widely available to purchase with ease, they vary in price ranging from around $50 to $300 
and more. You don’t have to have a huge assortment of filters to go with your camera kit, a polarizer, cooling filter, 
warming filter and a neutral density filter would be the most valuable filters to invest in. Once you look after them 
correctly they should last you a lifetime. It is important to remember that filters come in various diameters. Be sure to 
check the diameter of your lens before you purchase a filter. I hope that this article was a useful insight for you and 
that I will be of some assistance to you when choosing or using your filters.

Without Diffusion Filter With Diffusion Filter

Without Gradual Filter With Gradual Filter

This article and photographs contained are Copyright © and courtesy of Kenneth Fagan. Please contact the author directly with any questions.
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Photoshop Tutorial
Last month, Fred McWilson gave us an excellent tutorial for creating OOB 
(Out of Bounds) images, allowing us to really make our pictures jump off 
the page! This month, Fred kickis it up another notch by teaching us how to 
achieve some creative frame warping and shading effects!

ADVANCED OOB (OUT OF BOUNDS) EFFECTS WITH FRAME WARPING - By Fred McWilson

Welcome back fellow OOB creators! I hope 
that the first OOB tutorial in last months 
PhotographyBB Online Magazine has spurred 

your interest in pushing this technique even further, if 
so then you have come to the right place! In the first 
tutorial we learned what “OOB’s” are and how to create 
them. In this second tutorial we are going to blow past 
some of the basic straight-edged frames and warp 
into frame and space-time curvature…well maybe just 
frame curvature!

Quick note to image editors, the “Warp” tool is only found 
in Photoshop versions CS2 & CS3 currently. For Element 
users see the note at the end of this article for a work-
around that can give you some of the same results.
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When I first learned how to create an OOB image 
and studied others works I noticed most if not all used 
the familiar straight-edged white framing that photos 
of old commonly had. These OOB’s had very little what 
I like to call “frame interaction or frame bending” being 
employed in these images. I think one reason for this 
was due to the editing tools at the time were somewhat 
limited in dealing with this very effectively. Now with 
the advent of the “Warp” tool found in Photoshop 
versions CS2 and up, this kind of manipulation has 
become so much easier for the editor. Most of the 
OOB’s I viewed used the frame strictly as the boundary 
to achieve the 3D effect and rightly so. In this tutorial 
we are going to take the frame a step further and give 
it a little more life and ‘warp’ past the constraints of the 
straight-edged frame style.

Frame warping considerations:

Although any OOB creation that has a frame 
can have the frame bent, curved or warped from the 
subtle:

To the more extreme: 

However, some considerations should be taken. In 
the first example with the lizard, the frame has just 
been warped on one of the corners of the frame for a 

more subtle effect. The second more radical image of 
the little rodent the frame has had much more frame 
manipulation and even a little frame interaction. It is 
up to you as the image editor to decide how much or 
little of frame warping to apply. So when considering 
to warp your frame you need to think about a few 
things. First, will the frame warping add to the overall 
effect in some positive way. Secondly, how much frame 
‘warpage’ to apply and to what degree. Overall you will 
want your image to be enhanced by frame warping 
not overwhelmed by it. When frame warping I try to 
think about the image and how warping would make 
the image more interesting or how the frame could be 
interacting in some way as a result of the image such as 
example of the jet wheel bending the frame.

Or in this example of the dinosaur’s foot depressing 
the frame so that the swamp is being drained. 

Another aspect to the frame being warped to me is 
the effects of giving the overall image a more dynamic 
feel to it, rather than the more static look of the 
straight-edged OOB’s. Both have their place and use 
and if you let the image you are editing help guide you 
to determining whether or how much frame warping 
to do I think you will end up with much better results.
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The tutorial:
In this tutorial I used the same image used in the first tutorial to continue to build upon the OOB editing tools we 
used there plus the new tools used to create the warp effects.

You can find the tutorial image here:
http://www.flickr.com/photos/serrator/153709954/sizes/o/in/set-72157594146002408/

In addition to the warp tool we will also venture into the frame shading a little bit more to help create an even more 
believable final image. I hope you find this tutorial helpful in giving you a few more tools and techniques to put in 
your editing tool belt and most importantly…to have fun while editing! 

Note: Unfortunately for Element users the Warp tool is not available, it was introduced into Photoshop CS2. Element 
users though, can use the “Liquify” filter to achieve some amount of frame manipulation. You can find this in the 
pulldown menu Filter>Distort>Liquify. Although not as controllable as the warp tool, frame bending can be done 
with some patience. Be sure to have the frame layer active when you do the Liquify filter and don’t be afraid to 
enlarge your brush size to help with smooth sweeping bends.  

Frame “Thickness”
One last bit, I have been asked numerous times on how I add “thickness” to some of my frames. This is simply done 
by duplicating the frame layer once the frame warping or even just straight-edged frames work is completed. Once 
the frame layer has been duplicated adjust it’s white color to a gray color by using the Levels sliders found in Imag
e>Adjustments>Levels, adjust it just enough to distinguish it from the white of the other original frame layer. Then 
just drag this new frame layer below the main image layer. Then using the Move tool, slightly move the new frame 
from out behind the other frame layer to give the frame a thick look. 

A Note From the Editor of PhotographyBB Online Magazine...
Hello! I just wanted to make a note regarding the format of this tutorial. The author, Fred McWilson, has 
put together a fabulous ebook style tutorial, and rather than re-writing it and formatting it to our layout, 
we are going to present his original format in reduced size here. You may wish to zoom in to 150% or 
higher to view the tutorial nicely. We’ll also provide a link to download the tutorial PDF file.
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This article and all image contained are Copyright © are courtesy of Fred McWilson. Please contact the author directly with any questions.

PhotographyBB would like to thank Fred McWilson for sharing these tutorials with our readers. To download Fred’s PDF files 
for these tutorials, click the following link: http://www.logicscape.com/oob_tutorials/
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Actions in Action!
You’ve probably heard all about Photoshop® Actions by now, and maybe 
even downloaded a few. In this series, I’ll show you how you can create 
your own useful actions to automate those repetitive tasks. In this issue,I’ll 
show you how to create a simple frame which will add a subtle touch when 
sharing your image on the web.

SIMPLE BUT STYLISH: FRAMING YOUR WEB PHOTOS - By Dave Seeram

Welcome back to “Actions in Action!” From your emails, I’ve seen that some of you (hopefully all of you!) have 
missed this section of the magazine. As a result, I’m back to give you more ideas for automating repetitve 
tasks, thereby speeding up your digital workflow.

Nowdays, almost every digital photographer is posting their photos on the web. Be it online galleries, photo sharing 
sites, social networking sites, or forums (like the great PhotographyBB Forum!) - we’re all doing it. This month, I’m 
going to show you a short little tutorial on how to make a web frame action, which will give your images that extra 
bit of “finish” before posting them on the web.

Step 1: Open an image to work with. Open up your actions palette (Window>Actions) and create a new Action Set 
(by clicking the folder icon at the bottom of the actions palette). Next, create a new action (by clicking the “Create 
New Action” option at the bottom of the actions palette).

Step 2: This step is optional (feel free to alter these 
settings to your discretion), but we need to size the image 
appropriately for the web. For most cases, an image no 
larger than 640 pixels on it’s longest side should be more 
than adequate for most web viewing. To do this, (with your 
action recording), go to the menu: File>Automate>Fit 
Image... Here is where we will size the image to 640 pixels 
on it’s longest side. Enter the values of 640 pixels for 
both the width and height. By doing this, we will be able 
to resize the image to 640 pixels maximum whether the 
image is in landscape or portrait mode.

Step 3: Next, go to the menu: Image>Image Size... Change the resolution value to 72 pixels/inch (if it’s already 72 
pixels per inch that’s ok!), and uncheck the Resample Image checkbox at the bottom. Click OK.

Step 4: Next, double click on the Background layer in your layer’s palette, and rename it to Layer 0. Click OK. 

Step 5: Go to the menu: Layer>Layer Styles>Stroke... and 
change the following settings:

 Size: 1 px
 Position: Inside
 Color: Black

You can leave all of the other settings as they originally 
were set. Click OK to continue.
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Step 6: While holding down the Control key (PC) or Command key (Mac), click the Create New Layer icon at the 
bottom of the layers palette. Holding down Control/Command will create this new layer under our previous layer.

Step 7: We want to extend the canvas now, to create a 
nice white border around the image. Go to the menu: 
Image>Canvas Size...
You’ll want to enter “20” for both the width and height 
fields, however, make sure to change the units to pixels, 
rather than inches. Also, check the little checkbox that 
says “Relative” and click OK. 

Step 8: Press the letter “D” to reset the color swatches back to their defaults (Black/White). Next, press 
Control+Backspace (PC) or Command+Delete (Mac) to fill this new layer with white.

Step 9: The final step is to add just a subtle little 
embellishment to the frame. 

Go to the menu: Layer>Layer Styles>Inner Glow...
Here, you’ll want to change a few settings. Change the 
blend mode to “Multiply,” reduce the opacity to 30%, 
change the color from its default (usually a yellowish 
color) to black, leave the Choke at 0, and make the size 5 
px, as shown here.

Also, before you click OK, click on the Stroke layer style at 
the bottom left of the Layer Styles dialog box, and use the 
exact same settings you used in step 5.

And you’re finished! Let’s have a look at a before and after image to see how this subtle little frame can add just that 
extra impact to get your photos well noticed, and professionally presented when posting them on the web.

Before:             After:

This article and all image contained are Copyright © are courtesy of Dave Seeram. Please contact the author directly with any questions.
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Dreamweaver Basics
In today’s age of digital photography, the modern photographer is finding 
that not only do they need to be a good photographer, but they need to 
know things like image post-processing techniques, and even basic HTML to 
create their digital galleries on the web. In this column, we’ll look at some 
basic steps in Dreamweaver for building your photo websites.

A LOOK AT THE FIRST STEPS IN CREATING YOUR WEBSITE - By Victoria Sargsyan

Yes, the photographer needs to wear many different hats these days. A photographer of the digital era also 
needs to know how to display their wonderful photographs in a digital gallery (online). In this article series, I’ll 
walk you through the basic steps of building a website with Adobe Dreamweaver®. Although there are several 
ways of organizing your site’s directories and files, I be showing you the steps which I use in building websites. 
This first tutorial will be brief, showing you where to begin when working with Dreamweaver and getting your 
local folders set up for your website. Let’s begin!

Step 1: Open Dreamweaver. This is the default screen which will appear when you first launch Dreamweaver.
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Step 2: From the “Create New” list on the screen, choose “Dreamweaver Site...” and a dialog box will appear. From 
here, click on the “Advanced” tab up at the top, and we’ll work on the options shown here.

Step 3: From here, we are going to begin setting up the structure of our site, and the folders to where files and 
images will be saved. Click on the “Local Info” option from the choices on the left. Before we can get our website 
onto the Internet, we are going to build a working site on our own computer first. Under “Site Name” choose a name 
for your site. Under “Local root folder” choose/create a folder for your website which will reside on your computer’s 
harddrive by clicking on the little folder icon to the right of that option. Navigate your harddrive to find a suitable 
location to save your website to (I am using my Local Disk (D:) Drive here) - Fig 1.3.  Now create a new folder (with an 
appropriate name, ie First and Last name). Mine will be called “Viktoriyas” as shown below in Fig 1.4):

Fig 1.3 Fig 1.4
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Step 4: With the previous dialog box still open, double click the folder you just created (to open it), and create a NEW 
folder inside that one, and name it appropriately. I called mine “Firstsite.” This way, you can create different versions 
of your site all in one main folder - Fig 1.5. Here’s what it looks like now in my example:

Double click on your project folder’s name (in this case “Firstsite”) and click “Select” to make this your site’s root 
folder - Fig 1.6. The root folder is the main location for the website, and will contain the webpage that will launch 
when your browser is pointed to http://www.yoursite.com where “yoursite” will be your own personal URL, which 
you will decide upon later. Now that we have the root location of the website set up, let’s have a look at the Local 
Info now.

Step 5: Now we are going to setup the next option in the Local Info dialog box, which is the “Default Images Folder.” 
Click on the little folder icon to the left of that option to choose a default folder to store site images into. Doing the 
same steps as above, navigate to your site’s root folder (in this case - Firstsite) and inside that folder, create a new 
folder called “Images.” Click on the folder, and press Select to make this your default images folder.

And here is what it will look like in your Local Info options now:

Fig 1.5 Fig 1.6
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This article and all image contained are Copyright © are courtesy of Victoria Sargsyan. Please contact the author directly with any questions.

About the Author: Victoria Sargsyan is a member of NAPP (National Association of Photoshop Professionals) and is a talented 
graphic artist and web designer with over 15 years professional experience. To see more from Victoria, visit her website where you 
can check out her galleries and additional tutorials at:
http://www.viktoriyaimage.com 

Step 6: Click OK to exit the Local Info options dialog box, and you’ll be brought back to the Dreamweaver start page. 
Notice on the right, you can see your local folder directories, where you will be saving your website files to:

There you have it! You are now through your first steps in setting up the proper local structure for your website. 
Although this was just a short tutorial to get your feet wet in setting up Dreamweaver, next month we’ll look at how 
to create text and add images into your webpage without having to know any HTML code. Later, we’ll go through 
how you upload the files from your Local Folder to a web host, so that your page can be accessed anywhere on the 
Internet. Step by step, you will have your digital web gallery up and running in no time!

Step 7: 
The final step we are going to take (for now) in setting 
up our site structure is to create the file which will be 
used for our site’s Homepage. Under the “Create New” 
options, click on “HTML.” A new, blank HTML page will 
appear, and the first thing to do is to save this as your 
site’s “index” (which is your homepage) file. Go to the 
File > Save... menu, and save the filename into your 
site’s ROOT folder (in this case - Firstsite), and name the 
file “index”. You do not need to add .htm or .html to 
this, as Dreamweaver automatically appends this.
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Photoshop Elements Tutorial
Throughout our first several issues, we’ve picked up a lot of friendly 
Photoshop Elements users who have been requesting some specific 
tutorials for Photoshop Elements. We listened, and we are happy to add 
a dedicated Photoshop Elements tutorials column to the PhotographyBB 
Online Magazine. Welcome Elements users, and enjoy!

IMPROVE DIGITAL PHOTOS QUICKLY WITH ELEMENTS - By Victoria Sargsyan

I’m not saying that your photos need improvement, but let’s face it - Our photos don’t always look the same on 
the computer as they did in real life. Sometimes our photos need just that extra bit of color correction, contrast 
adjustment, or sharpening just a tad to really make them “pop!”In this tutorial, I am going to show you a few 
quick steps using the Elements “Quickly Fix Photo” options, to further enhance your photos. 

Step 1: Open Photoshop Elements and click on “Quickly Fix Photo.”
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Step 2: Open the photo which you are going to work on. Here you can see 2 windows: The bottom of the screen 
shows a thumbnail of your original photo, and the top of the screen is the photo shown as you apply modifications 
to it. 

On the fixed photo you can see 3 buttons: “Actual Pixels”, “Fit Screen”, and “Print Size”.  I am going with “Fit Screen” 
which will fit my image in full, to the size of my window.

On the left side of the screen you can see the panel with following 
tools : Zoom Tool, Hand Tool, Magic selection brush tool, Crop Tool, 
and Red Eye Removal Tool (We will take the closer look at those 
tools in next month’s tutorial).

Off to the right side of your screen you’ll see General Fix, Lighting, Color, and  the 
Sharpen tools, which we will be working with today:
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Step 3:
Here, I’ll go through the different options, and their effect on your image. It would be helpful if you follow along in 
Elements on a photo of your own so you can visually see the results on the fly.

General Fix: 
Here you can see “Smart Fix” and “Red Eye Fix”.  This is an easy way to improve your photos, however, I prefer to 
improve my photos manually. One never knows what the final result will be!

Lighting:
Here you can see “Levels” and “Contrast”, both of them working as “Auto Levels” and “ Auto Contrast.” Click on the 
auto button, and Elements will automatically adjust the levels and contrast with it’s own optimum settings based 
on your image.

Also here you can see Lighten Shadows, Darken Highlights and Midtone Contrast. These are very powerful, great, 
and extremely helpful options. Here is where you can really fine tune your image. Try it with one of your images, and 
adjust the different sliders to see their effect. Here is a brief description of what each slider actually does:

 Lighten Shadows:    Increases the brightness only in dark areas of your image.
 Darken Highlights:  Decreases the brightness in the highlight (bright) areas of your image.
 Midtone Contrast:   Adjusts the contrast in areas with medium brightness (midtones). Here is where you
                                         can pull out a lot of hidden detail in your images.

Experiment with those sliders. Try several different settings before you settle on a final result. Take your time and 
you will be surprise with the results. If you make any mistakes or wish to start over, you can click the “Reset” button 
at the top right corner of your image.

Color:
Here you can see Auto button for an easy fix or try playing with the:
Saturation - Intensity or vibrancy of the colors in your image.
Hue - Here you can shift the color tones in your image for some creative effects. 
Temperature - This refers to the color temperature (See the filters article for more detail). You can make your image 
feel more “warm” or “cool” by adjusting this slider.
Tint - Here you can add a tinted color overlay onto your image. Try reducing the saturation slider all the way to the 
left (to remove all color), then slide the tint slider around to “tint” your image with a color. You can further use the 
Hue slider to choose the color of the tint you just applied.

Sharpen:
Here you can see the Auto button for an automatic sharpening adjustment, or for more control (and fun), use:
Amount - Use the slider to increase the amount of sharpening on your image. Try experimenting with oversharpening 
for a very cool artistic effect.

Here’s a look at my final before/after results: (Notice the additional details in the clouds, trees, and water).

Before After

This article and all image contained are Copyright © are courtesy of Victoria Sargsyan. Please contact the author directly with any questions.
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Member in the Spotlight

Each month, we’ll feature a “Spotlight” on one of our site’s forum members 
and tell you a little bit about who they are, how they got started, what their 
photographic interests are, and display some of their work. 

FEATURE ON MEMBER:  Victoria Sargsyan

PBB MAG: Victoria, thank you for joining us, it’s great to have you here! Let’s give our readers an introduction 
to you. Tell us about yourself Victoria!

Hello PhotographyBB and readers! I am really happy to be joining you as the Spotlight Member this month. My 
name is Victoria Sargsyan. I am from Armenia where I worked as a graphic designer for 7 years. Recently, I moved 
to the United States where I have now been living for the past 4 years.  I currently work as a freelance graphic and 
web designer, and I just love the photographic opportunities that I have here in the USA. I absolutely love working 

Victoria Sargsyan is one of our earliest and founding forum members on the PhotographyBB Forums. Since joining 
us and being one of the most active forum members, she is also a respected moderator for the PhotographyBB 
Forums, as well as a recurring author for the PhotographyBB Online Magazine.
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with Adobe Photoshop and using it to create digital 
artwork. Additionally, I am happy to say that I am one 
of the moderators for the PhotographyBB forums, and 
I have been writing tutorials for the PhotographyBB 
Online Magazine for the past 4 issues, with more fun 
stuff on the way!

PBB MAG: What type of photographic equipment 
and software do you use? Do you have any favourite 
gear that you always bring with you on a shoot?

I am actually fairly new to shooting digital. I currently 
shoot with a Nikon D40, a camera which I absolutely 
love. I’ve been using it now for over a year, when I 

made the switch from film to digital. I have to say, I 
do prefer digital to film. I love the world of processing 
opportunities I have when working with digital images. 
Photoshop is one of my favourite programs, and I enjoy 
the endless possibilities there are for manipulating 
digital photos, enhancing them, converting them, or 
turning them into digital artwork.

For my lenses, I have a nice collection of Nikon lenses 
for the D40, including Nikon’s 18-55mm, a 55-200mm, 
a NIKKOR 18-35mm f/3.5-4.5D IF-ED, and my newest 
lens, an AF-S VR NIKKOR 300mm f/2.8G IF-ED. Out of all 
of these, I would have to say that I like my 18-55mm the 
best because I tend to enjoy wide angle shooting, and 
this one gives me the quality and versatility to capture 
most of my scenes.

On the software side, I use a wide range of software 
depending on the type of work I am doing. My favourite 
is Adobe Photoshop, but I also enjoy using Photoshop 
Elements, Illustrator, Corel Painter, 3DStudiomax, 
Poser7, Anime Studio, Image Ready, Freehand, and 
Motion Artist. In my web work, I use Dreamweaver, MS 
SQL, and Visual Basic.net.

As for the gear I like to bring to a shoot: I’ll always have 
my Nikon D40 on me, as well as my entire collection of 
lenses. I never know which one I’ll want to use if I get 
a sudden inspiration from a scene. I also make sure to 
always bring a tripod to my shoots.

Boston Streets at Night.

One of my favourite swan photos.
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PBB MAG: Victoria, do you remember what first got 
you interested in doing photography and digital 
artwork?

Yes, I remember 20 years ago, when I finished my 
schooling at a painting college; I’ve always enjoyed 
painting and drawing. After my graphic design 
education and learning about Photoshop 10 years ago, 
and what could be done on the computer digitally, I was 
hooked! Since then I’ve been into Photoshop, digital 
art and photography, and trying to improve my works 
every day. I am also currently finishing my education in 
programming, to bring my portfolio to the next level 
through web programming.

PBB MAG: Photographically, what’s your favourite 
discipline? (I.e. landscapes, portraits, nature, etc...)

My favourite photographic subjects are people. I love 
being able to capture various expressions on people’s 
faces, as well as their eyes. There’s a lot of power in being 
able to capture expression on people’s faces. I prefer to 
shoot unexpected or candid shots. That way I am able 
to capture a “natural moment” or expression, which I 
believe has more impact when shooting people.

I also enjoy urban photography and being able to 
capture “city shots.” I live near Boston, which is one of 
my favourite places to photography some great wide-
angle city street shots. I totally enjoy shooting “rainy” 
city shots too. For me, if it’s raining in the city, there’s no 
better time to go out shooting!

PBB MAG: Victoria, in looking at your digital 
artwork, I can see you have a lot of talent in your 
digital paintings and photo compositions. Can you 
tell us a little bit about your technique, and where 
you get your inspiration from?

I love to recreate paintings digitally (freehand) using my 
Waccom tablet and pen on my PC. I mostly love doing 
paintings of celebrities, especially of my favourite singer 
- Elvis! Sometimes when I am doing a digital painting, 
I will use up to 130 layers in Photoshop, to make sure I 
get the lighting and shading effects just right.

As for my digital artwork, the inspiration comes from 
many places. Sometimes I’ll be inspired to do artwork 
based on a movie I just saw, or a song that gives me 
a particular mood. Other times, the inspiration comes 
from my heart.

Here’s a Photoshop piece I did entitled “Earthquake”Digital painting from photo entitled “Swan in the Night”
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PBB MAG: It’s been great not only talking with you, 
but also working with you on the magazine Victoria. 
Before you go, do you have any advice that you 
would like to share with anyone who’s wanting to 
take “the next step” in photography? 

Definitely! For anyone out there who is interested 
in learning new things, new techniques, or new 
programs... I would say to keep practicing always. 
Practice makes perfect, and you will learn to refine 
your techniques. Try to spend as much time as you 
can on your works. Remember to always keep positive 
and enjoy learning and practicing. Also, read as much 
as you can about the programs you are interested in, 
and learn as many tutorials as possible. You can find 
so many great tutorials on the internet, or in books 
also. Digital photography and photo manipulation can 
take years of practice, but it can also be a lot of fun 
at the same time. Chat with people on photography 
forums (like the PhotographyBB Forums), and you’ll 
meet lots of people with similar interests to you, and 
you can all learn from each other. Never be afraid of 
making mistakes, because with each mistake you will 

learn something new. Also, try new things, and you’ll 
be suprised at how creative you are!

Digital painting done with the Waccom tablet and pen. This piece is entitled “The Night Before Halloween.”

A freehand digital drawing of my favourite singer, Elvis!
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This article and photographs contained are Copyright© courtesy of Victoria Sargsyan. Contact the author directly with any questions.

Above: One of my favourites 
entitled “The Forgotten”

Left: This is one of my digital 
artworks from my “Tired Angel” 
series of works. 

To see more images in this series, 
or to view more of my work, visit 
the PhotographyBB Forums and 
you’ll find me to be quite active in 
the Digital Art forums.

I hope to see you there!

Victoria is a member of NAPP (National Association of Photoshop Professionals), experienced graphic designer and 
digital artist who’s always willing to lend a hand or offer some advice. She’s one of our Photoshop On Demand 
helpers, so if you have any Photoshop questions, visit the forums and chat with Victoria. If you would like to learn 
more about Victoria and view some of her photography and artwork, please visit Victoria’s online gallery at:

http://www.viktoriyaimage.com
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What are the PhotographyBB Forums?

The PhotographyBB Forums are a place for anyone and everyone with a keen interest in digital photography or image 
editing, to gather around and chat with each other, ask questions, post comments, and share photos. You’ll find things 
like Photoshop Tutorials, photo galleries, digital photography discussions and tips for improving your photography, 
along with fun stuff like Photoshop games, photography challenges and more! Try your hand at some of the games 
like the Photoshop “Invisibles” challenge, or if you are a Photoshop Guru yourself - have a Photoshop Tennis match!

PhotographyBB Forums are geared towards beginners, and the number one rule on our site is respect. You’ll find that 
makes us one of the friendliest photography sites on the Internet. Everyone of any skill level from beginner to expert 
is welcome to participate without fear, since we are all there to help each other improve and inspire one another. 
Browse the forums and you’ll quickly see the respect our members have for each other, and how you may fit in with 
the fine folks who visit us everyday. 

We also launched the Photoshop H.O.D. (Help On Demand) section last month, which has been hugely successful. 
If you require any sort of Photoshop assistance, post your Photoshop question, and you’ll usually receive an answer 
within minutes!

If you would like to chat with any of the authors of the PhotographyBB Online Magazine, or the editor himself, drop on 
by the PhotographyBB Forums and say hi. Registration is completely free; all you need is a login name and password. 

Happy Photographing, and we’ll see you on the forums.

Visit the PhotographyBB Forums and participate today!
http://www.photographybb.com/forum/

Visit our team on
The PhotographyBB

Forums
PHOTOGRAPHYBB: A WELCOMING FORUM TO BEGINNERS, AND EXPERT USERS ALIKE!



Pa
ge

 57

PhotographyBB Online Magazine

Have a Great 
Idea for a 

Photography 
Article?

We are looking for 
talented individuals 

who would like to 
expand their portfolios 

by volunteering to 
contribute articles to 

this e-magazine! If you 
are interested, we’d 

love to hear from you.

Topics of Interest are:

- Photography Techniques
- Photography on Location
- Photoshop Tutorials
- Hardware / Software Reviews
- Camera Equipment
- Member Spotlight
- Plus we’re open to new ideas!

To become either a regular 
contributing author, or even 
just for a one-time article, 
please email us at: 

magazine@photographybb.com

Introduce yourself, share your 
idea, and maybe we’ll see you 
in next month’s issue!

Step into the Spotlight!
Would you like to be featured in the PhotographyBB 
Online Spotlight on Member section? If so, please let 
us know at: magazine@photographybb.com

We’ll feature your photos, a small biography and write-
up about you, as well as links to your web gallery or 
photography related business. We all love photography 
and image editing, so let’s get to know each other!

Next Month’s Issue:
Issue 5 for June will have a lot of new columns for us. 
We’ve taken on a few new writers, which I am pleased 
to say will bring fresh and exciting content to the 
magazine. Stay tuned for a few suprises!

We’ll also continue our popular series of “Photography 
Around the World” as we take you on a photographer’s 
view of far away and exotic places which just might 
make you feel like you are actually there!

This month we had a great series of tutorials, and next 
month gets even better. We had to postpone a few of 
the previously mentioned upcoming tutorials, but have 
no fear - they are in press for future issues. Next month 
we’ll dive deeper into Dreamweaver, along with a new 
series on HDR (High Dynamic Range) Photography.

Discounts for Readers:
If you are a regular visitor to the PhotographyBB Online 
Website, you may have noticed down the sidebar, a 
section called “Coupons of The Month.” This section 
contains various photography related coupons and 
deals such as free photo prints, and discounts on books 
and software. If you are planning to buy these things 
anyways, visit us and use a coupon!

Thank you for reading the PhotographyBB Online 
Magazine. We hope  you enjoyed it, and we’d love to 
see you again next month. If you have any questions or 
comments for us regarding this magazine, please feel 
free to email us at:

magazine@photographybb.com

We would love to hear from you!


